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In	the	previous	blog	post,	I	shared	how	to	speed	up	your	Classic	to	RDLC	reports	transformation	by	using	the	FREE	Express	version	of	1ClickFactory’s	Classic	to	RDLC	report	transformation	tool.	In	this	post	I	will	use	the	same	example,	show	how	you	can	easily	create	a	word	layout	from	RDLC,	also	how	to	get	a	report	with	both	RDLC	and	Word
layouts.	Step	#1:	Create	Word	layout	We	will	create	a	Word	layout	by	running	the	report	and	saving	its	result	to	Word.	Run	report	5055	Contact	–	Cover	Sheet	from	NAV	development	environment.	Choose	to	print	it	to	Word.				Now	copy	the	contents	from	the	first	page	and	paste	it	into	the	Word	layout.	Select	contents	in	the	first	page.			Now	go	back
to	NAV	2015	development	environment	and	open	the	design	of	report	5055.	Go	to	report	properties	and	set	WordMergeDataItem	to	Contact.	This	part	is	very	important	to	do	before	inserting	the	new	Word	layout.			From	the	tools	menu,	choose	Word	Layout	>	New.			After	the	blank	Word	layout	is	inserted	in	report	object,	choose	Tools	>	Word	Layout
>	Export,	and	enter	the	file	name	where	it	should	be	exported.	Open	the	exported	file	in	Word,	and	paste	the	layout	from	the	earlier	Word	file.	Paste	the	content	from	the	earlier	Word	document’s	first	page.				Open	the	XML	mapping	window.	Choose	dataset	namespace	in	Custom	XML	Part.				Replace	the	text	with	contact	controls.			Save	the	Word	file,
and	test	how	it	looks	when	used	in	Word	Layout.	Step	#2:	Test	Word	Layout	From	NAV	2015	report	design,	choose	Tools	>	Word	Layout	>	Import,	and	select	the	saved	Word	document.			Save	the	report	and	run	it	from	the	development	environment.	Press	Preview	on	the	request	page.	Notice	the	Word	message	that	pops	up.			A	Happy	Ending	In	these
two	blog	posts,	we	shared	an	example	of	how	to	upgrade	a	Classic	report	to	NAV	2015	for	free	and	with	a	functioning	RDLC	layout.	By	running	the	RDLC	report	and	saving	to	Word,	we	were	able	to	create	a	Word	template	for	the	report‘s	Word	layout	design.	We	then	replaced	text	with	content	controls	and	ended	up	with	a	report	with	both	RDLC	and
Word	layouts.	Now	end	users	can	tweak	the	design	of	the	report	in	their	favorite	program:	Word.	Good	luck	in	your	transformation	journey!	Author	of	the	post:	1ClickFactory	Associate	Paulius	Grigas.	Before	we	get	into	design	of	reports	in	Microsoft	Dynamics	NAV	2013	and	Microsoft	Dynamics	NAV	2013	R2,	its	important	to	understand	what’s
required.	Apart	from	access	to	NAV	development	environment	and	developer’s	license,	the	following	are	required:	>>To	Design	reports	in	Microsoft	Dynamics	NAV	2013	we	require	Microsoft	Visual	Studio	2010	SP1	Professional,	Premium,	or	Ultimate.	>>To	Design	reports	in	Microsoft	Dynamics	NAV	2013	R2	we	need	to	use:	Microsoft	Visual	Studio
2012/2013	Professional,	Premium,	or	Ultimate	edition	(Microsoft	Visual	Studio	2013	is	only	supported	if	Microsoft	Dynamics	NAV	is	updated	according	to	Knowledge	Base	article	2907585.)	OR	Microsoft	SQL	Server	Report	Builder	for	Microsoft	SQL	Server	2012/2012	Sp1	or	Microsoft	SQL	Server	2008	R2	Report	Builder	3.0	(Microsoft	Dynamics	NAV
2013	R2	Setup	installs	Microsoft	SQL	Server	Report	Builder	for	Microsoft	SQL	Server	2012	if	it	is	not	already	installed	on	the	target	computer.)	In	NAV	2013	R2,	you	can	choose	to	design	or	modify	the	report	layout	using	Visual	studio	or	SQL	Server	Report	Builder.	You	can	switch	between	these	2	designers	by	going	to	development	environment–>
Tools–>	Options–>Use	Report	Builder(yes	or	No)	please	note	:	The	Visual	Studio	Report	Designer	provides	design	functionality	that	SQL	Server	Report	Builder	does	not	support.	For	example,	in	Report	Builder,	you	do	not	have	a	document	outline	view.	Also,	fields	that	you	add	to	the	table	in	the	development	environment	are	not	added	automatically
to	the	report	dataset	in	Report	Builder.	Report	Builder	functionality	that	requires	access	to	a	SQL	Server	Reporting	Services	server	is	not	supported.	This	includes	running	the	report	from	Report	Builder,	and	adding	Report	Parts.	I	have	reffered	to	multiple	videos	from	Microsoft’s	channel	on	YouTube	in	this	post.	It	showcases	how	we	can	build	reports
in	NAV	using	Visual	studio	from	scratch.	Simple	List	Report	in	Microsoft	Dynamics	NAV	2013	The	first	video	in	this	section	shows	how	easy	it	is	to	build	a	simple	Customers	list	report	in	Microsoft	Dynamics	NAV	2013	with	page	header,	page	footer,	image	etc..	from	scratch.	This	is	a	great	video	for	the	beginners.	The	output	of	the	report	is	shown	in
the	below	image:	Customers	List	Report	This	video	explains	How	to:	Build	a	simple	list	report	in	Microsoft	Dynamics	NAV	2013	using	Visual	studio	2010.	You	can	try	this	report	in	NAV	2013	R2	with	Visual	studio	2012/2013	as	well:	Grouping	Data	in	reports:	The	next	video	shows	how	the	above	report	(customers	list)	can	be	grouped	country	wise.	It
also	shows	how	you	can	group	data	and	add	sub	totals	in	reports.	The	output	of	the	grouped	report	is	shown	in	the	below	image:	Customers	list	grouped	on	Country	How	Do	I:	Group	data	in	Microsoft	Dynamics	NAV	2013	Reports	(You	can	try	this	report	in	NAV	2013	R2	with	Visual	studio	2012/2013	as	well):	Additional	video	on	Grouping	data	in
Microsoft	Dynamics	NAV	2013	R2.	View	Report	Dataset	One	can	view	all	the	data	being	fetched	from	Dynamics	NAV	for	a	report.	This	can	be	seen	using	the	“About	this	report”	feature.	How	Do	I:	View	My	Report	Dataset	in	Microsoft	Dynamics	NAV	2013	R2	Similar	to	above	videos,	there	are	many	more	useful	NAV	reporting	videos	available	on
YouTube	channel	and	MSDN.	I’ve	listed	most	of	them	below:	List	of	all	How	Do	I	videos	on	Dynamics	NAV	are	available	here	In	my	next	blog	post	under	Dynamics	NAV	report	design,	I	will	explain	how	we	can	design	NAV	reports	using	SQL	server	report	builder.	By	default,	a	report	will	have	a	built-in	report	layout,	which	can	be	either	an	RDLC	report
layout	or	Word	report	layout,	or	both.	You	cannot	modify	built-in	layouts.	However,	you	can	create	your	own	custom	layouts	that	enable	you	to	change	the	appearance	of	report	when	it	is	viewed,	printed	or	saved.	You	can	create	multiple	custom	report	layouts	for	the	same	report,	and	then	switch	the	layout	that	is	used	by	a	report	as	needed.To	create
a	custom	layout,	you	can	either	make	a	copy	of	an	existing	custom	layout	or	add	a	new	custom	layout,	which	in	most	cases	is	based	on	a	built-in	layout.	When	you	add	a	new	custom	layout,	you	can	choose	to	add	an	RDLC	report	layout	type,	Word	report	layout	type,	or	both.	The	new	custom	layout	will	automatically	be	based	on	the	built-in	layout	for
the	report	if	one	is	available.	If	there	is	no	built-in	layout	for	the	type,	then	a	new	blank	layout	is	a	created,	which	you	will	have	to	modify	and	design	from	scratch.	For	more	information	about	RDLC	and	Word	report	layouts,	built-in	and	custom	layouts,	and	more,	see	About	Report	Layouts.In	the	Search	box	of	the	Microsoft	Dynamics	NAV	Windows
client	or	Microsoft	Dynamics	NAV	Web	client,	enter	Report	Layout	Selection,	and	then	choose	the	related	link.The	Report	Layout	Selection	window	lists	all	the	reports	that	are	available	in	the	company	that	is	specified	in	the	Company	field	at	the	top	of	the	window.	Set	the	Company	field	to	the	company	in	which	you	want	to	create	the	report
layout.Select	the	row	for	the	report	that	you	want	to	create	the	layout	for,	and	then	on	the	Home	tab,	in	the	Process	group,	choose	Custom	Layouts.The	Custom	Report	Layouts	window	appears	and	lists	all	the	custom	layouts	that	are	available	for	the	selected	report.	If	you	want	to	create	a	copy	of	an	existing	custom	layout,	select	the	existing	custom
layout	in	the	list,	and	then	on	the	Home	tab,	in	the	New	group,	choose	Copy.The	copy	of	the	custom	layout	appears	in	the	Custom	Report	Layouts	window	and	has	the	words	Copy	of	in	the	Description	field.If	you	want	to	add	a	new	custom	layout	that	is	based	on	a	built-in	layout,	do	the	following:On	the	Home	tab,	in	the	New	group,	choose	New.The
Insert	Built-in	Layout	for	a	Report	window	appears.	The	ID	and	Name	fields	are	automatically	filled	in.To	add	a	custom	Word	report	layout	type,	then	select	the	Insert	Word	Layout	check	box.	To	add	a	custom	RDLC	report	layout	type,	then	select	the	Insert	RDLC	Layout	check	box.Choose	the	OK	button.The	new	custom	layouts	appear	in	the	Custom
Report	Layouts	window.	If	a	new	layout	is	based	on	a	built-in	layout,	then	it	has	the	words	Copy	of	a	Built-in	Layout	in	the	Description	field.	If	there	was	no	built-in	layout	for	the	report,	then	the	new	layout	has	the	words	New	Layout	in	the	Description	field,	which	indicates	that	custom	layout	is	blank.By	default,	the	Company	Name	field	is	blank,	which
means	that	the	custom	layout	will	be	available	for	the	report	in	all	companies.	To	make	the	custom	layout	available	in	a	specific	company	only,	on	the	Home	tab,	in	the	Manage	group,	choose	Edit,	and	then	set	the	Company	Name	field	to	the	company	that	you	want.The	custom	layout	has	been	created.	You	can	now	modify	the	custom	layout	as	needed.
For	more	information,	see	How	to:	Modify	a	Custom	Report	Layout.	For	information	about	how	to	make	the	custom	layout	the	current	layout	for	the	report,	see	How	to:	Change	Which	Layout	is	Currently	Used	on	a	Report.	A	report	dataset	can	consist	of	fields	that	display	labels,	data,	and	images.	This	topic	describes	the	procedure	for	adding	fields	of
a	report	dataset	to	an	existing	Word	report	layout	for	a	report.	You	add	fields	by	using	the	Word	custom	XML	part	for	the	report	and	adding	content	controls	that	map	to	the	fields	of	the	report	dataset.	Adding	fields	requires	that	you	have	some	knowledge	of	the	report's	dataset	so	that	you	can	identify	the	fields	that	you	want	to	add	to	the	layout.	For
more	information	about	custom	XML	parts,	see	Custom	XML	Part	Overview	for	Word	Report	Layouts.Note	You	cannot	modify	built-in	report	layouts	from	a	Microsoft	Dynamics	NAV	client.	You	can	modify	a	built-in	layout	from	the	Microsoft	Dynamics	NAV	Development	Environment	only.If	not	already	open,	then	open	the	Word	report	layout	document
in	Word.	For	more	information,	see	How	to:	Modify	a	Custom	Report	Layout.Show	the	Developer	tab	in	the	ribbon	of	Microsoft	Word.By	default,	the	Developer	tab	is	not	shown	in	the	ribbon.	For	more	information,	see	How	to:	Show	the	Developer	Tab	on	the	Ribbon.On	the	Developer	tab,	choose	XML	Mapping	Pane.In	the	XML	Mapping	pane,	in	the
Custom	XML	Part	dropdown	list,	choose	the	custom	XML	part	for	Microsoft	Dynamics	NAV	report,	which	is	typically	last	in	the	list.	The	name	of	the	custom	XML	part	has	the	following	format:urn:microsoft-dynamics-nav/reports/report_name/IDreport_name	is	the	name	that	is	assigned	to	the	report	as	specified	by	the	report's	Name	Property	in	the
Microsoft	Dynamics	NAV	Development	Environment.ID	is	the	identification	number	of	the	report.After	you	select	the	custom	XML	part,	the	XML	Mapping	pane	displays	the	labels	and	field	controls	that	are	available	for	the	report.Place	your	cursor	in	the	document	where	you	want	to	add	the	control.In	the	XML	Mapping	pane,	right-click	the	control
that	you	want	to	add,	choose	Insert	Content	Control,	and	then	choose	Plain	Text.Note	You	cannot	add	a	field	by	manually	typing	the	dataset	field	name	in	the	content	control.	You	must	use	the	XML	Mapping	pane	to	map	the	fields.In	a	table,	add	a	table	row	that	includes	a	column	for	each	field	that	you	want	repeated.This	row	will	act	as	a	placeholder
for	the	repeating	fields.Select	the	entire	row.In	the	XML	Mapping	pane,	right-click	the	control	that	corresponds	to	the	report	data	item	that	contains	the	fields	that	you	want	repeated,	choose	Insert	Content	Control,	and	then	choose	Repeating.Add	the	repeating	fields	to	the	row	as	follows:	Place	your	pointer	in	a	column.In	the	XML	Mapping	pane,
right-click	the	control	that	you	want	to	add,	choose	Insert	Content	Control,	and	then	choose	Plain	Text.For	each	field,	repeat	steps	a	and	b.A	report	dataset	can	include	a	field	that	contains	an	image,	such	as	a	company	logo	or	a	picture	of	an	item.	To	add	an	image	from	the	report	dataset,	you	insert	a	Picture	content	control.	Images	align	in	the	top-left
corner	of	the	content	control	and	resize	automatically	in	proportion	to	fit	the	boundary	of	the	content	control.Important	You	can	only	add	images	that	have	a	format	that	is	supported	by	Word,	such	as	.bmp,	.jpeg,	and	.png	file	types.	If	you	add	an	image	that	has	a	format	that	is	not	supported	by	Word,	you	will	get	an	error	when	you	run	the	report	from
the	Microsoft	Dynamics	NAV	client.Place	your	pointer	in	the	document	where	you	want	to	add	the	control.In	the	XML	Mapping	pane,	right-click	the	control	that	you	want	to	add,	choose	Insert	Content	Control,	and	then	choose	Picture.To	increase	or	decrease	the	image	size,	drag	a	sizing	handle	away	from	or	towards	the	center	of	the	content	control.
Tip	For	more	information	about	how	to	work	with	fields	and	columns,	see	Work	with	Data.	For	more	information	about	how	to	find	specific	pages,	see	Search.	Open	the	MS	Office	Word.	File	->	New	and	type	Invoice	in	search	and	press	enter	to	list	available	Invoice	Templates.	In	my	example	I	am	using	[Sales	Invoice	(Blue	Border	Design)]	Select
Create	to	download	the	template	and	create	a	document	for	you.	Your	new	document	created	from	this	template	will	look	as	below:	Prepare	the	Layout	by	removing	extralines	as	we	will	be	using	repeating	lines	for	Lines.	Save	your	Template.	I	have	made	a	copy	of	Report	206	–	Sales	–	Invoice	on	new	ID	say	(50005	as	Sales	–	Invoice	Word).	This	report
dosen’t	have	Word	Layout.	We	will	be	creating	one	Customize	Layout	form	above	saved	Invoice	above.	[Sales	Invoice	(Blue	Border	Design)]	Open	Report	Layout	as	shown	in	below	Screen:	Slect	the	Report	and	choose	Custom	Layout	as	shown	in	above	screen.	In	Custom	Report	Layout	Window	Click	on	New.	From	window	Insert	Build-in	Layout	for
Report	Select	Insert	Window	Layout	and	click	OK	button.	From	Custom	Report	Layout	window	Select	Import	Layout,	Select	your	word	file	prepared	above	and	Respond	Open	to	Import.	Then,	press	Edit	Layout	and	prepare	layout	on	Developer	tab,	find	XML	Mapping	Pane	and	find	your	document	in	Custom	XML	Part.	Now,	you	can	find	all	fields	from
Dataset.	Please	see	below	links	to	complete	your	report:	Adding	image	fields	Add	fields	from	a	report	dataset	to	a	word	report	layout	Creating	my	first	word	list	report	in	Navision	2015	How	to	specify	the	default	built	in	report	layout	Create	a	word	report	layout	for	a	report	Once	you	are	done	with	your	field	assignment	close	the	word	layout.	Select
Yes	to	import	changes	to	the	report.	Select	Run	Report	to	view	the	output	of	your	report.	Now	you	are	done	with	your	Custom	Report	Layout.	Please	see	sections	which	will	be	more	helpful	to	complete	your	task:	Reports	Company	was	incorporated	under	sub-section	(2)	of	section	7	of	Companies	Act,	2013	and	rule	18	the	Companies	(Incorporation
Rules,	2014.	Company	Directors	are	(1)	Ashwini	Tripathi	&	(2)	Rashmi	Tripathi	We	provide	wide	range	of	services	currently	only	for	Microsoft	Dynamics	Navision.	(1)	Freelancing	(2)	Virtual	Employee	(3)	Hourly	basis	service	(4)	Dedicated	resource	(5)	Training	You	can	hire/	contract/	offshore	work.	Provide	assistance	and	service	for	Implementation,
Development	and	Upgrade.	We	are	also	Partner	under	Affiliate/MVAR	Program	for	NAV,	AX	&	CRM.	Currently	we	are	servicing	to	only	international	customers.	We	have	associated	with	some	Indian	Companies	to	service	International	Customers.	We	have	provided	service	to	Microsoft	Affiliated	Partners	too.	We	have	our	own	customers	too.	View	all
posts	by	Ashwini	Tripathi	December	9,	2014Submitted	by	Tom	MarshelloReading	time:	5	minsIn	every	implementation	of	Microsoft	Dynamics	NAV	(Navision)	I	have	worked	on,	it	has	been	requested	that	we	change	the	way	that	the	customer	facing	invoice	looks.	This	is	not	an	unusual	request	as	every	business	is	unique,	so	it	is	natural	to	want	your
invoice	to	look	the	way	you	want	it	to.	Now,	if	you	aren’t	adept	at	modifying	the	invoice	report	yourself	(which	is	close	to	100%	of	the	time),	then	it	requires	a	custom	modification	done	by	a	NAV	developer,	which	of	course,	adds	cost	to	the	project.	Well,	that	is	no	longer	the	case!	We	can	now	rejoice	and	throw	huge	parties	filled	with	decadent	food
and	drink,	full	body	massages,	and	presents	worthy	of	a	rock	star,	because	Dynamics	NAV	2015	has	put	the	power	of	invoice	editing	into	the	general	layman’s	hands!	OK,	so	maybe	it	is	not	as	exciting	as	I	might	portray	it	to	be,	but	it	really	is	very	cool!	NAV	2015	lets	you	take	an	existing	report,	modify	it	in	Microsoft	Word,	and	then	use	the	new
modified	report.	Pretty	slick!	Let’s	take	a	look	at	a	very	simple	example	of	how	to	accomplish	this.	From	the	navigation	pane,	select	Administration	>	IT	Administration	>	Reports:	Figure	1	–	NAV	2015	Navigation	Pane	The	first	step	is	to	create	a	new	Custom	Report	Layout.	Select	Custom	Report	Layouts	from	the	reports	menu,	and	in	the	window	that
opens,	press	the	New	button	in	the	top	left	corner:	Figure	2	–	Custom	Report	Layouts	Window	Select	the	report	you	wish	to	modify,	choose	to	Insert	the	Word	Layout,	and	press	OK.	In	our	example,	we	are	going	to	modify	Report	1306	–	Sales	–	Invoice,	which	has	an	existing	Word	layout	to	modify.	Note	that	if	no	Word	Layout	exists	for	that	report,	you
will	have	to	create	one	from	scratch.	Figure	3	–	New	Custom	Report	Layout	Window	After	pressing	OK,	you	will	notice	that	a	Custom	Report	Layout	Line	has	been	created.	You	can	now	specify	which	company	you	want	the	new	layout	to	apply	to.	I	have	selected	to	use	this	layout	in	the	CRONUS	USA,	Inc.	company.	The	cool	part	about	this	is	that	you
can	create	different	layouts	for	different	companies!	Figure	4	–	Custom	Report	Layout	Line	Before	we	edit	the	report	layout,	let’s	first	take	a	look	at	what	the	sales	invoice	looks	like	in	its	current	state:		Figure	5	–	Unedited,	Boring	Invoice	Now	it	is	time	to	edit	it!	From	the	Home	ribbon	of	the	Custom	Report	Layouts	window,	press	Edit	Layout.	Figure
6	–	Custom	Reports	Layout	Window	Since	we	specified	that	this	is	a	Microsoft	Word	Layout,	lo	and	behold,	Microsoft	Word	magically	opens!	In	Word,	make	the	changes	you	desire.	I	have	made	the	following	blatantly	obvious	change	to	the	invoice	for	our	example:	Figure	7	–	Microsoft	Word	Window	After	making	your	changes,	save	the	Word	document
and	close	it.	Upon	closing	it,	you	will	be	prompted	with	the	following	dialog	box.	Answer	Yes	to	import	the	layout:	Figure	8	–	Import	Changes	Dialog	box	Finally,	we	need	to	tell	NAV	to	use	the	new	report	layout	we	created.	From	the	Reports	page,	choose	Report	Layout	Selection.	In	this	window,	find	the	report	you	created	the	layout	for	and	change
the	Selected	Layout	to	“Custom	Layout.”	Figure	9	–	Report	Layout	Selection	Window	This	will	open	a	list	of	the	custom	layouts	you	created	for	that	report	(remember	there	could	be	more	than	one).	Select	the	one	you	want	to	use	and	then	Press	OK	and	OK	again	to	close	both	windows.	Let’s	now	take	a	look	at	the	edited	invoice!	Drum	roll	please…..
Figure	10	–	Awesome	Edited	Invoice	So	how	does	it	feel	to	be	an	invoice	editing	rock	star?	Pretty	good,	right?	I	think	that,	like	all	rock	stars,	you	deserve	a	drink	(or	five,	as	rock	stars	frequently	indulge	in)!	And	I	can	think	of	no	better	drink	to	recommend	on	this	cold	winter	day	than	this	tasty	Hot	Mulled	Wine!	I’ve	made	it,	it’s	awesome…just	like
you!	Read	more	“How	To”	blogs	from	ArcherPoint	for	practical	advice	on	using	Microsoft	Dynamics	NAV.	After	you	design	a	dataset	for	a	report,	you	can	create	a	Word	report	layout	that	can	be	used	when	you	view	and	print	a	report	from	the	Microsoft	Dynamics	NAV	client.	This	topic	describes	how	to	create	blank	a	Word	report	layout	on	a	report
from	the	Microsoft	Dynamics	NAV	Development	Environment.	After	you	create	the	layout,	you	can	modify	the	layout	to	include	dataset	fields	and	define	the	general	format.In	the	development	environment,	open	the	report	in	Report	Dataset	Designer	as	follows.	On	the	Tools	menu,	choose	Object	Designer.	In	Object	Designer,	choose	Report,	select	the
report,	and	then	choose	the	Design	button.On	the	Tools	menu,	choose	Word	Layout,	and	then	choose	New,	and	then	choose	the	OK	button.Note	If	the	New	item	is	inactive,	then	the	report	already	has	a	Word	report	layout.Save	the	report	object.A	blank	Word	report	layout	is	created	on	the	report	object.	The	report	layout	includes	a	custom	XML	part
for	the	current	report	dataset.	You	can	now	design	the	layout	in	Word.	For	more	information,	see	How	to:	Modify	a	Word	Report	Layout.Designing	Word	Report	Layouts	In	the	development	environment,	open	the	report	in	Report	Dataset	Designer	as	follows.	On	the	Tools	menu,	choose	Object	Designer.	In	Object	Designer,	choose	Report,	select	the
report,	and	then	choose	the	Design	button.	On	the	Tools	menu,	choose	Word	Layout,	and	then	choose	New,	and	then	choose	the	OK	button.	Save	the	report	object.	A	blank	Word	report	layout	is	created	on	the	report	object.	The	report	layout	includes	a	custom	XML	part	for	the	current	report	dataset.	You	can	now	design	the	layout	in	Word.	A	Word
report	layout	determines	the	content	and	format	of	a	report	when	it	is	viewed	and	printed	from	the	Microsoft	Dynamics	NAV	client.	When	you	modify	a	Word	report	layout,	you	specify	the	fields	of	the	report	dataset	to	include	on	report	and	how	the	fields	are	arranged.	You	also	define	the	general	format	of	the	report,	such	as	text	font	and	size,
margins,	and	background	images.	You	will	typically	arrange	the	content	of	the	report	by	adding	tables	to	the	layout.	You	insert	dataset	fields	in	the	layout	by	using	a	custom	XML	part	that	is	automatically	generated	for	the	report	when	you	create	the	Word	report	layout.Filed	under:	Report	Tagged:	2015,	Create,	Dynamics,	Layout,	Microsoft,	MS,	Nav,
Navision,	Report,	Word	From	NAV	2015	and	on	it	is	possible	to	handle	the	report	layout	in	word.	Let’s	look	how	you	do	it	in	NAV	2016.	First	create	a	new	report	and	add	the	needed	dataitems.	As	an	example,	we	want	to	create	a	customer	list	with	addresses.	Save	report	and	we	are	ready	for	start	adding	the	layout.	First	we	have	to	create	and	empty
layout	(Tools	->	Word	Layout	->	New)	and	afterwards	export	it	(Tools	->	Word	Layout	->	Export),	so	that	we	can	edit	it	in	word.	Open	the	exported	document	in	Word	and	you	will	see	a	blank	page	To	be	able	to	add	the	fields	from	Navision,	you	have	to	enable	the	Developer	Tab	(or	Udvikler,	since	my	Word	is	Danish).	In	the	Developer	Tab	you	then
click	on	the	XML	Mapping	Pane	(XML-	tilknytningsrude)	and	a	sidebar	will	open.	Here	you	chose	the	XML	mapping	that	belongs	to	your	report.	(The	name	of	the	report	is	part	of	the	mapping	name)	Now	you	can	see	your	dataitems/fields	defined	in	the	report	and	can	now	add	them	to	the	report.	A	tip	is	to	use	a	table,	and	then	added	the	repeater
(Customer)	around	it,	then	it	will	create	one	line	per	customer	like	in	the	good	old	reports.


